Documenting Patient Immunization

British Columbia 2018/19
# Table of Contents

Documenting Patient Immunization - British Columbia ................................................................. 3

Immunization Module Features ........................................................................................................ 4

Configuration .................................................................................................................................. 5
  Marketing Message Setup ............................................................................................................... 6

Paper Mode ...................................................................................................................................... 9
  Creating a Paper Immunization Record .......................................................................................... 9
  Scanning a Paper Immunization Record ......................................................................................... 14
  Billing an Immunization .................................................................................................................. 16
  Completing Immunizations ‘Saved for Later’ ................................................................................ 17
  Recording Emergency Epinephrine Shots ....................................................................................... 17
  Reprinting an Immunization Record .............................................................................................. 20
  Viewing Immunization Record Details .......................................................................................... 21

Electronic Mode .............................................................................................................................. 24
  Creating an Electronic Immunization Record ............................................................................... 24
  Emergency Contact ....................................................................................................................... 26
  Patient Consent ............................................................................................................................. 27
  Billing an Immunization .................................................................................................................. 37
  Completing Immunizations ‘Saved for Later’ ............................................................................... 38
  Recording Emergency Epinephrine Shots ..................................................................................... 38
  Reprinting an Immunization Record .............................................................................................. 43
  Viewing Immunization Record Details .......................................................................................... 44

Cancelling a Claim ........................................................................................................................... 48

Declined or Refused Immunizations ............................................................................................... 49
  Pharmacist Declined ..................................................................................................................... 49
  Patient Refused ............................................................................................................................. 52

Status Types ..................................................................................................................................... 55
  Status ........................................................................................................................................... 55
  Product Status ............................................................................................................................... 55
  Fee Status ..................................................................................................................................... 56

Reporting .......................................................................................................................................... 57
  Method 1: Selecting Drugs in the Report Form ............................................................................. 57
  Method 2: Using Drug Groups ....................................................................................................... 59
  Setting up a Drug Group ................................................................................................................. 59
Documenting Patient Immunization - British Columbia

Immunization is one of the most important and cost-effective public health innovations. In Canada, immunization has saved more lives than any other health intervention, and has contributed to the reduction in morbidity and mortality from a broad range of vaccine-preventable diseases in adults, children and other vulnerable populations.

Immunization providers are responsible and accountable to ensure that the information entered is accurate and timely and in accordance with their particular professional practice standard. The pharmacist/health care provider must keep a permanent record of immunization history by ensuring the documentation includes the required information:

- Client’s name
- Health Card Number (HCN)
- Vaccine Name
- Lot number
- Dose number in series
- Route administered
- Immunization site
- Dose
- Signature of immunizer
- Date of immunization
- Adverse events following immunization

Your pharmacy must have Kroll V10 SP7 or higher in order to use this functionality.

**NOTE:** The examples used in this manual may not reflect the actual drug product used in your pharmacy. Available drug products vary by season.
Immunization Module Features

The Immunization module introduces a simple and streamlined approach to managing and documenting administered immunizations in Kroll that will improve the way your pharmacy manages immunizations. A list of features included with the functionality is below:

- All immunization records are saved to the Immunization section of the patient card, separate from all other patient records.
- Screening questions are used to determine if the patient is eligible for immunization; answers to these questions are stored in the database and are viewable from the patient card.
- Vaccine administered, lot number, expiry date, time and date of immunization, route and site of administration, dose, and pharmacist information is recorded.
- Signatures can be captured on-screen or on paper, giving your pharmacy flexibility in how immunizations are handled.
- In Electronic Mode, the billing process has been streamlined to facilitate faster and more accurate billing.
- Emergency contact information is recorded.
- Emergency Epinephrine shots can be easily added to an immunization record.
- Marketing messages can be configured to print at the bottom of receipts to encourage patients to get their vaccinations.
Configuration

Configuration settings for the Immunization module are located in the **Store Level Configuration Parameters** screen (**File > Configuration > Store > Rx > 8 - Immunization**). Each of the settings on this screen is explained below.

![Store Level Configuration Parameters](image)

- **Enable electronic immunization**: Turns on electronic immunization functionality. When this setting is enabled, all immunization documentation takes place on-screen; when it is disabled, immunization documentation is recorded in paper mode.

- **Require electronic signature for Pharmacists**: Requires the pharmacist to record an electronic signature using a digital signature tablet. Note that electronic signature functionality must be setup in order to use this feature.

- **Require UPC Verification of Vaccine Product**: Requires the user to scan or enter the UPC number associated with the administered vaccine.

- **Message on Receipt for patients eligible for Influenza shots / Print for all retail patients / Print for NH patients**: Allows users to enter an Influenza marketing message that will print at the bottom of receipts for retail patients and/or nursing home patients.
The following two options were newly added, and do not affect the flu shot functionality:

- **Allow to use non-influenza immunization products obtained externally**: Allows pharmacist to accept non-influenza immunization products for injection in the following two scenarios:
  - Patient brings in product that was dispensed from another pharmacy
  - When patient is required to take more than one injection of a product on separate days, and is coming in to the same pharmacy the product was dispensed to them with the second or third vaccine of the same product.

- **Allow to use non-influenza immunization Rx dispensed ___ days ago**: Allows pharmacist to put an expiry date for number of days from when an Rx is dispensed to be treated as a recently dispensed Rx.

**Marketing Message Setup**

An Influenza marketing message can be entered in the **Store Level Configuration Parameters** screen to remind patients to get the flu vaccination. The message prints at the bottom of the receipt for retail and/or nursing home patients, and is typically used in the weeks leading up to and during the flu season.

**NOTE**: The Influenza marketing message will replace the Receipt Free Form message (**Labels > 4 - Receipt**) if one has been entered.

1. Select File > Configuration > Store > Rx > 8 - Immunization.
2. Select Print for retail patients to have the marketing message print on retail patients’ receipts, or Print for NH patients to have the marketing message print on nursing home patient’s receipts.
3. Enter your desired marketing message in the space provided. Use the **Font** and **Font Size** controls to customize the appearance of the text.

4. Enter the **Start Date** and **End Date** of the Influenza season. The marketing message will print on the receipts for eligible patients between these dates.

   If you want the message to print on the receipt only for patients in a specific age range, enter **Min Age** and **Max Age** values.
5. Click **OK** to save changes to the **Store Level Configuration Parameters** screen. The marketing message will print at the bottom of all receipts during the specified date range for patients who have not yet received immunization. Once immunization has been administered, the message will no longer print for that patient.
Paper Mode

Immunizations documented in Paper Mode are printed from the patient card, completed on paper, and scanned back into Kroll using the Document Scan Utility.

Note that the ‘Enable electronic immunizations’ configuration setting (File > Configuration > Store > Rx > 8 - Immunization) must be disabled in order to record immunizations in Paper Mode.

Creating a Paper Immunization Record

1. Call up a patient using the F3 - Patient search.

2. Select Immunizations from the right navigation pane.
3. Select **N - New Immunization**.

![Immunization Screen]

**NOTE:** If you attempt to create an immunization record before a product list for the current season has been provided, the following prompt will appear:

![Prompt]

You will not be able to document patient immunization until the product list has been provided.

4. Select an immunization type from the list and click **Print Now**. Or, if you want to add the immunization record to the Immunizations queue in order to print the immunization form later, click **Save for Later**. See the **Completing Immunizations ‘Saved for Later’** section for more information.

![Immunization Queue]

**NOTE:** When there is no Influenza Immunizations saved, only the ‘Non-Influenza’ option will be displayed in the drop down. However, once Influenza immunizations records have been created, both the ‘Non-Influenza’ and ‘Influenza’ options will be displayed in the drop-down menu in the ‘Immunization’ screen.
5. The **Immunization Report** form will appear. It is recommended that you print at least one Epinephrine Emergency Treatment so treatment information can be recorded if the patient has an adverse reaction to the immunization.

If no Epinephrine Emergency Treatment is selected and the patient requires this treatment, a new Immunization Report must be printed so the emergency treatment can be recorded.

![Image of Immunization Report form]

6. Click **Print**.

7. The **Immunization Record** will print. Provide this printout to the patient for him or her to fill out. Have the pharmacist complete the **PHARMACY USE ONLY** portion.

**NOTE:** The products listed in the **INFLUENZA VACCINE** portion of the Immunization Record may change depending on the current season.
Immunization Record (patient portion):

Immunization Record
Kroll Pharmacy, 100 Kroll Drive, Vancouver BC V2V 2V2
Phone: (222) 222-2222 Fax: (888) 888-8888

PATIENT INFORMATION

<table>
<thead>
<tr>
<th>First Name</th>
<th>Last Name</th>
<th>Patient</th>
<th>Gender</th>
<th>Date of Birth</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tracking #: 70

SCREENING QUESTIONNAIRE

For children 6 months of age and older, at least one flu shot is recommended.

The following questions will help us determine if there is any reason you or your child should not get the flu shot today. If you answer *yes* to any question, follow the necessary steps outlined in the Important Notice at the beginning. If you answer *no* to all questions, additional questions may still be asked.

If a question is not clear, please ask your pharmacist to explain it.

Are you or your child currently infected with flu-like illness?

Yes  No  Unsure

Do you have a history of egg allergy? (including chocolate, mustard, or mayonnaise)

Yes  No  Unsure

Are you currently taking anything that may affect your immune system? (i.e. corticosteroids, chemotherapy, immune system suppressors)

Yes  No  Unsure

Are you currently taking a blood-thinning medication?

Yes  No  Unsure

Do you have a history of chronic illness?

Yes  No  Unsure

Are you taking antihistamines or decongestants?

Yes  No  Unsure

Are you or your child pregnant?

Yes  No  Unsure

CONSENT GIVEN BY PATIENT

I, the undersigned, patient, parent, or guardian, have read and understand the information about the flu vaccine outlined in this sheet. I have asked all questions, and the answers are to my satisfaction. I understand the risks and benefits of receiving the flu shot. I agree to wait in the pharmacy for 15 minutes to ensure a non-life-threatening reaction to the flu vaccine.

I certify that I have read and understood the information about the flu vaccine.

Patient Signature

Date: 19-Oct-2016

PHARMACIST DECLARATION

I confirm the above information is true and complete.

Pharmacist Signature

Date: 19-Oct-2016

Immunization Record (pharmacy portion):
# Immunization Record

**PHARMACY USE ONLY**

<table>
<thead>
<tr>
<th>Test</th>
<th>Last Name</th>
<th>Gender</th>
<th>DOB</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Patient</td>
<td>M</td>
<td>01-Jan-1980</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Address:**
123 Any St. Vancouver BC A1A 1A1

**Phone Number:**
(123) 456-7890

---

## Influenza Vaccine

<table>
<thead>
<tr>
<th>Product Description</th>
<th>DIN</th>
<th>00Y</th>
<th>000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agriflu 15.15 mcg/0.5 mL (Pack Size 0.5 mL)</td>
<td>02346850</td>
<td>66124873</td>
<td>0.5 mL</td>
</tr>
<tr>
<td>Agriflu Influenza Vaccine 15.15 mcg/0.5 mL (Pack Size 5 mL)</td>
<td>02428881</td>
<td>66124873</td>
<td>0.5 mL</td>
</tr>
<tr>
<td>Fluar 15.15 mcg/0.5 mL (Pack Size 0.5 mL)</td>
<td>02362384</td>
<td>66124872</td>
<td>0.5 mL</td>
</tr>
<tr>
<td>Fluar 15.15 mcg/0.5 mL (Pack Size 5 mL)</td>
<td>02420783</td>
<td>66128005</td>
<td>0.5 mL</td>
</tr>
</tbody>
</table>

**Route of Administration**: Site of Administration

**Lot Number**: Expiry Date

## Epinephrine Emergency Treatment

<table>
<thead>
<tr>
<th>Product Description</th>
<th>DIN</th>
<th>00Y</th>
<th>000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allerject 0.15 mg/0.15 mL (Pack Size 1 PEN)</td>
<td>02382059</td>
<td>1 PEN</td>
<td></td>
</tr>
<tr>
<td>Allerject 0.3 mg/0.3 mL (Pack Size 1 PEN)</td>
<td>02382067</td>
<td>1 PEN</td>
<td></td>
</tr>
<tr>
<td>Epinephrine Injection 1 mg/mL (Pack Size 1 ML)</td>
<td>02325225</td>
<td>1 ML</td>
<td></td>
</tr>
<tr>
<td>Epinephrine 0.5 ml/mL (Pack Size 1 PEN)</td>
<td>00509558</td>
<td>1 PEN</td>
<td></td>
</tr>
</tbody>
</table>

**Route of Administration**: Site of Administration

**Lot Number**: Expiry Date

**Comments**: Date/Time of Injection

---

Page 2 of 2
Scanning a Paper Immunization Record

**NOTE:** If you will be scanning all immunization records in a single batch at the end of the day, skip these steps and continue to the [Billing an Immunization](#) section.

1. From the Alt+X - *Start* screen, go to *Utilities > Printed Document Scan/Import*.

2. The *Import Scanned Documents* screen will appear. Place the report pages in the scanner hopper. Check *Scan both sides of paper* if you are scanning pages with information on both sides and your scanner supports dual side scanning. Click *Start Scanning*.
3. When scanning is complete, the screen will indicate how many pages were scanned successfully and how many will need to be manually reconciled. When you are finished, click **Process and Reconcile**.

![Import Scanned Documents](image)

4. The **Document Scan Reconciliation** screen will appear. Items ready to be processed will appear in the **Documents to be created** section. Items that need to be reconciled will appear in the **Unprocessed Images** section.

5. If all pages were scanned successfully and appear in the **Documents to be created** section, click the **Process Pending Documents** button. Click **Cancel** to close the screen.

6. Once scanning is complete, the **Status** of the immunization record will change from **Printed Consent** to **Signed Consent**.

![Immunizations](image)
The report will be saved to the Immunization record and to the **Documents** section of the **F3 - Patient** card.

**Billing an Immunization**

1. Once the scanning process is complete, select the immunization record from the patient card and click **F - Claim Fee**.

2. The **F5 - Drug** search screen will appear. Search for and select the product that was administered to the patient.

3. If the user who performed the immunization has an **F7 - Doctor** record with a ‘Pharmacist’ designation, that user’s information will populate in the doctor section of the **F12** screen.

   If the user does not have an **F7 - Doctor** record or if the immunization was performed by a different user, the **F7 - Doctor** search form will appear. Perform a doctor search to locate the pharmacist to use as the prescriber.

4. Enter the ML quantity in the **Disp Qty** field and complete all remaining fields.

5. Click **F12 - Fill Rx**. The claim will be transmitted to the appropriate party for payment.
6. Once billing is complete, the **Status** of the immunization record will change from **Signed Consent** to **Completed Paper**, and the **Product Status** will change from **Pending Claim** to **Claimed**.

### Completing Immunizations ‘Saved for Later’

Immunization records that have been ‘saved for later’ can be accessed either via the **F3 - Patient** card or the **F9 - Workflow** card.

1. Call up the patient using the **F3 - Patient** search or select **F9 - Workflow**.

2. Select **Immunizations** from the right navigation pane.

3. Select the immunization record you want to complete and click **P - Print/Reprint**.

4. Complete steps 5 - 13 of the [Creating a Paper Immunization Record](#) section.

### Recording Emergency Epinephrine Shots

An emergency Epinephrine shot may be required if the patient has a reaction to the immunization. This section explains how to add emergency Epinephrine shots to an immunization record.

**NOTE:** Emergency Epinephrine shots can only be added to immunization records that have a status of ‘Completed’.

1. Call up a patient using the **F3 - Patient** search.

2. Select **Immunizations** from the right navigation pane.
3. Right-click a completed immunization record and select **Add Epinephrine shot**.

![Immunizations table]

4. The **F5 - Drug** search form will appear. Search for and select the Epinephrine medication that was administered to the patient.

5. The **F7 - Doctor** search form will appear. Perform a doctor search to locate the pharmacist to use as the prescriber.

6. A claim for the treatment will populate in the **F12** screen. Ensure the **Disp Qty** field shows ‘1’ to represent the number of administered treatments.
7. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

8. Complete all remaining workflow steps as required.

9. A record of the emergency Epinephrine show will be added to the Immunizations list with a Status of ‘Completed’ and a Product Status of ‘Claimed’.
Reprinting an Immunization Record

This section explains the process for reprinting completed immunization records. Immunizations can be reprinting either via the **F3 - Patient** card or the **F9 - Workflow** card. Note that immunization records must have a status of ‘Completed’ to be reprinted; records with a status of ‘Pending’, ‘Declined by Pharmacist’, or ‘Refused by Patient’ cannot be reprinted.

1. Call up the patient using the **F3 Patient** search, or select **F9 - Workflow**.

2. Select **Immunizations** from the right navigation pane.

3. Select the appropriate immunization record and click **P - Print/Reprint**.

4. The **Immunization Report** form will appear. Select the number of Epinephrine Emergency Treatments you want printed in the report.

5. Click **Print**. The selected record will generate.
Viewing Immunization Record Details

This section explains how to view the details of an Immunization record. Immunization records can be viewed either via the F3 - Patient card or the F9 - Workflow card.

1. Call up the patient using the F3 Patient search, or select F9 - Workflow.

2. Select Immunizations from the right navigation pane.

3. Call up the record by doing one of the following:
   - Right-click the record you want to view and select View Details;
   - Select the record and press F2;
   - Double-click the record.
4. The Immunization View screen will appear. If the immunization record has not yet been scanned into the system, a blank screen showing ‘No Scanned Documents Found’ will appear.
If the immunization record has been scanned into the system, the scanned record will appear in the **Immunization View** screen. From here you can adjust the brightness, contrast, and saturation of the record, or print the record.

5. Click **Close** to exit the **Immunization View** screen.
Electronic Mode

Immunizations documented in Electronic Mode are completed on-screen in the **Immunizations** section of the patient card. A digital signature pad can be used to capture pharmacist signatures electronically, or the completed record can be printed, signed, and scanned into Kroll using the Document Scan Utility.

Note that the ‘Enable electronic immunizations’ configuration setting (File > Configuration > Store > Rx > 8 - Immunization) must be enabled in order to conduct immunizations in Electronic Mode.

---

Creating an Electronic Immunization Record

1. Call up a patient using the **F3 - Patient** search.

2. Select **Immunizations** from the right navigation pane.
3. Select **N - New Immunization**.

![Immunization Record Selection](image)

**NOTE:** If you attempt to create an immunization record before a product list for the current season has been provided, the following prompt will appear.

![Immunization Prompt](image)

You will not be able to document patient immunization until the product list has been provided.

4. Select an immunization type from the list and click **Perform Now**. Or, if you want to add the immunization record to the Immunizations queue in order to complete the immunization form later, click **Save for Later**. See the **Completing Immunizations ‘Saved for Later’** section for more information.
Emergency Contact

1. Search for and select an emergency contact. This is the person who will be contacted in the event of an emergency.

2. Specify the contact’s **Relationship** to the patient and enter their phone number(s).

NOTE: If the patient has an emergency contact saved to the **F3 - Patient** card (Other tab), the contact’s information will prepopulate in the Emergency Contact fields and the **Patient Consent** tab will be displayed.

If the patient has more than one emergency contact saved to the **F3 - Patient** card, select the desired contact from the list.

3. To save the emergency contact to the **F3 - Patient** card, click **Save to Patient**. The emergency contact will be inserted in the **Other** tab in the **F3 - Patient** card.
4. Click Next.

**NOTE:** A daytime phone number for the emergency contact is required to proceed.

**Patient Consent**

1. Select the appropriate answer for each of the Patient Consent questions.

- Some answers may preclude the patient from receiving immunization. For example, if the patient answers **Yes** to ‘Are you sick today?’, he or she will be ineligible for immunization.
Other answers may present a note to the pharmacist. For example, if the patient answers Yes to ‘Are you allergic to latex gloves?’, a note will appear instructing the pharmacist to not use latex products.
If the system determines the patient is ineligible for immunization, all consent questions will become read-only. Click **Refuse Immunization** and complete the **Enter a Comment** form. See the [Declined or Refused Immunizations](#) section for more information.

2. Once the patient has answered each of the Patient Consent questions and the pharmacist has determined the patient is eligible for immunization, click **Print Consent**.

**NOTE:** All questions must be answered in order to proceed.

3. The **Immunization Report** form will appear. Click **Print**.

4. The **Influenza Vaccine Consent Form** will print. This form shows each of the Patient Consent questions and their answers for the patient to review.
### Influenza Vaccine Consent Form

**PATIENT INFORMATION**

<table>
<thead>
<tr>
<th><strong>First Name</strong></th>
<th><strong>Last Name</strong></th>
<th><strong>Gender</strong></th>
<th><strong>DOB</strong></th>
<th><strong>Weight</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>01-Jan-1980</td>
<td>200lbs</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Address</strong></th>
<th><strong>HealthCard</strong></th>
<th><strong>Phone Number</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>123 Any St, Vancouver BC V1V 1V1</td>
<td></td>
<td>(123)456-7890</td>
</tr>
</tbody>
</table>

**SCREENING QUESTIONNAIRE**

- **Are you on a holiday (e.g., a fever greater than 39.5°C, breathing problems, or respiratory infection)?** No
- **Do you have a worsening of a serious medical disorder?** No
- **Have you had a serious adverse reaction to influenza vaccine in the past?** No
- **Have you ever had Guillain-Barre Syndrome or any other reaction following the influenza vaccine?** No
- **Have you experienced difficulty breathing or anaphylaxis within 4 hours of getting a flu shot?** No
- **Do you have an allergy to egg product?** Unsure
- **Do you have a history of egg allergies?** Yes
- **Do you currently take antiviral medication?** No
- **Do you have a history of urticaria?** No
- **Do you take blood thinners or have a bleeding disorder?** No
- **Are you or do you think you might be pregnant?** N/A

**CONSENT GIVEN BY PATIENT**

I, the undersigned patient, patient, and/or legal guardian of the patient, have read or have been given oral information about the influenza vaccination and the Fact Sheet. I understand the risks and benefits of receiving the influenza vaccine. I hereby consent to the administration of the influenza vaccine.

I am aware that:  
- The vaccine contains a preservative and an adjuvant, which may cause some side effects.  
- Serious side effects are rare.  
- The vaccine may not prevent all types of influenza.  
- If you develop fever or have any other side effects, please contact my pharmacist or doctor.

I, the undersigned patient, have received a copy of this form containing information on emergency treatments that have been received, or a copy will be provided upon request to LMPharmacists.

I confirm that I want to receive the seasonal influenza vaccine.

<table>
<thead>
<tr>
<th><strong>Patient/ Test</strong></th>
<th><strong>Patient Signature</strong></th>
<th><strong>Date/signed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>19-Oct-2016</td>
</tr>
</tbody>
</table>

**PHARMACIST DECLARATION**

I confirm the above named patient is/are capable of providing consent for seasonal influenza vaccine and that the seasonal influenza vaccine was administered to the patient.

<table>
<thead>
<tr>
<th><strong>Pharmacist: Kroll/Pharmacy (999999999)</strong></th>
<th><strong>Pharmacist Signature</strong></th>
<th><strong>Date/signed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>19-Oct-2016</td>
</tr>
</tbody>
</table>
5. Sign the consent form. Have the patient sign the form as well.

6. The **Scan Consent** tab will appear. If you have a document scanner attached to the workstation, you will be presented with the following options. Select one to continue.

- **Scan Patient Consent Form**: Allows you to scan the patient consent form into the system.

- **Select from Network Scan**: If you have already scanned the signed consent form and the file is saved to the network, select this option to import the form.

- **Proceed without Scan**: Allows you to continue processing the immunization without importing the signed consent form. All consent forms can then be scanned at the end of the day using the **Document Scan Utility**.

If you do not have a document scanner attached to the workstation, you will be presented with the following options. Select one to continue.

- **Select from File**: If you have already scanned the signed consent form and the file is saved to a local directory, select this option to import the form.

- **Select from Network Scan**: If you have already scanned the signed consent form and the file is saved to the network, select this option to import the form.
- **Proceed without Scan**: Allows you to continue processing the immunization without importing the signed consent form. All consent forms can then be scanned at the end of the day using the Document Scan Utility.
7. If you selected **Proceed without Scan** in the previous step, a warning will appear asking if you are sure you want to proceed without scanning the signed consent form. Answer **Yes**. Ensure you keep the signed paper copy for your records.

8. If the ‘**Require UPC verification**’ configuration setting is enabled, scan or enter the UPC from the drug pack. If a UPC match is found, product information will populate.

You may need to manually enter the lot number and expiry date if this information is not stored in the product barcode.
If the ‘Require UPC verification’ configuration setting is disabled, select a product from the list. Enter the Lot Number and Expiry Date associated with the drug.

9. Click Next.
10. The **Administration** tab will appear.

- Enter the site of administration in the **Site of Admin** field (e.g., left arm, right thigh).
- Select the pharmacist who administered the immunization from the **Administered by** list.
- Enter any comments in the space provided (optional).

11. Click **Finalize Immunization**.
NOTE: If the Administered by user is not the currently logged in user, the Administered by user will be required to enter their login credentials in order to proceed.

12. If you have electronic signatures enabled, the pharmacist will be prompted to sign the signature pad in order to proceed. Sign the signature pad and click OK.

13. A prompt will appear asking if you want to print an Immunization Record for the patient. Answer accordingly.
Billing an Immunization

1. The If the user who performed the immunization has an F7 - Doctor record with a ‘Pharmacist’ designation, that user’s information will populate in the doctor section of the F12 screen.

   If the user does not have an F7 - Doctor record or if the immunization was performed by a different user, the F7 - Doctor search form will appear. Perform a doctor search to locate the pharmacist to use as the prescriber.

2. A claim for the immunization will populate in the F12 screen. Ensure the Disp Qty field shows the ML quantity.

3. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

4. Complete all remaining workflow steps as required.
Completing Immunizations ‘Saved for Later’

Immunization records that have been ‘saved for later’ can be accessed either via the **F3 - Patient** card or the **F9 - Workflow** card.

1. Call up the patient using the **F3 - Patient** search or select **F9 - Workflow**.
2. Select **Immunizations** from the right navigation pane.
3. Select the immunization record you want to complete and click **F - Call up**.
4. Complete steps 5-26 of the [Creating an Electronic Immunization Record](#) section.

Recording Emergency Epinephrine Shots

An emergency Epinephrine shot may need to be administered if the patient has a reaction to the immunization. This section explains how to add Emergency Epinephrine shot records to an immunization record.

**NOTE**: Emergency Epinephrine shots can only be added to immunization records that have a status of ‘Completed’.

1. Call up a patient using the **F3 - Patient** search.
2. Select **Immunizations** from the right navigation pane.
3. Right-click a completed immunization record and select **Add Epinephrine shot**.
4. If the ‘Require UPC verification’ configuration setting is enabled, scan or enter the UPC from the drug pack. If a UPC match is found, product information will populate.

You may need to manually enter the lot number and expiry date if this information is not stored in the product barcode.
5. If the ‘Require UPC verification’ configuration setting is disabled, select a product from the list. Enter the **Lot Number** and **Expiry Date** associated with the drug.

6. Click **Next**.
7. The **Administration** tab will appear.
   - Enter the site of administration in the **Site of Admin** field (e.g., left arm, right thigh).
   - Select the pharmacist who administered the shot from the **Administered by** list.
   - Enter any comments in the space provided (optional).

8. Click **Finalize Immunization**.

9. If the user who performed the immunization has an **F7 - Doctor** record with a ‘Pharmacist’ designation, that user’s information will populate in the doctor section of the **F12** screen.
   
   If the user does not have an **F7 - Doctor** record or if the immunization was performed by a different user, the **F7 - Doctor** search form will appear. Perform a doctor search to locate the pharmacist to use as the prescriber.

10. A claim for the treatment will populate in the **F12** screen. Enter a **Disp Qty** of ‘1’ to represent the number of administered treatments.
11. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

12. Complete all remaining workflow steps as required.

13. A record of the emergency Epinephrine show will be added to the Immunizations list with a Status of ‘Completed’ and a Product Status of ‘Claimed’.

Repeat these steps for each Emergency Epinephrine shot that is administered to the patient.
Reprinting an Immunization Record

This section explains how to reprint an Immunization record. Immunizations can be reprinted either via the F3 - Patient card or the F9 - Workflow card.

1. Call up the patient using the F3 Patient search, or select F9 - Workflow.

2. Select Immunizations from the right navigation pane.

3. Select the appropriate immunization record and click P - Print/Reprint.

4. The Immunization Report form will appear. Select Full Report from the Print list to print the full report, or select Patient Immunization Record to print the Patient Immunization Record portion only.
Viewing Immunization Record Details

This section explains how to view the details of a completed Immunization record. Immunization records can be viewed either via the **F3 - Patient** card or the **F9 - Workflow** card.

1. Call up the patient using the **F3 Patient** search, or select **F9 - Workflow**.

2. Select **Immunizations** from the right navigation pane.

3. Call up the record by doing one of the following:
   - Right-click the record you want to view and select **View Details**;
   - Select the record and press **F2**;
   - Double-click the record.

![Immunizations Table]

---

*Note: The table above illustrates the process of viewing Immunization record details.*
4. The **Immunization View** screen will appear. If the immunization record has not yet been scanned into the system, only the immunization details that were recorded on-screen will be visible. Click **Print** to reprint the immunization record or full report, or **View Signature** to view the digital signature, if one was captured.
5. If the immunization record has been scanned into the system, the immunization details will display in the Immunization tab. Click Print to reprint the immunization record or full report, or View Signature to view the digital signature, if one was captured.
6. In the Documents tab, the scanned record will appear. From here you can adjust the brightness, contrast, and saturation of the record, or reprint the consent record.

NOTE: If you reprint the immunization document(s) from the Documents tab in the Immunization View screen, the scanned image of the original document(s) (not the original documents themselves) will print. As such, the resolution may not be optimal. See the Reprinting an Immunization Record section for instructions on how to reprint the original document(s).

7. Click Close to exit the Immunization View screen.
Cancelling a Claim

This section explains how to cancel an Immunization claim. Immunization claims can be cancelled either via the **F3 - Patient** card or the **F9 - Workflow** card.

1. Call up the patient using the **F3 Patient** search, or select **F9 - Workflow**.

2. Select **Immunizations** from the right navigation pane.

3. Select the appropriate immunization record and click **C - Cancel Claim**.

4. A prompt will appear asking if you are sure you want to cancel the Rx. Answer **Yes**.

5. Enter your user initials and click **OK**.

6. A prompt will appear stating you are cancelling the first fill of an Rx. Select **Filled in Error - Remove from profile**.

---

**Immunizations**

<table>
<thead>
<tr>
<th>N</th>
<th>Status</th>
<th>Product Status</th>
<th>Fee Status</th>
<th>Created</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Influenza</td>
<td>Completed</td>
<td>Claimed</td>
<td>No Fee Applicable</td>
<td>26/08/2016</td>
</tr>
</tbody>
</table>

**Confirm Rx**

Are you sure you want to Cancel this Rx?

- Yes
- No
- Cancel and Refill

**Select an Option**

You are canceling the first fill of an Rx. Do you want to:

- Make this Rx Unfilled
- Filled in Error - Remove from profile
7. A prompt may appear asking if you want to copy the “mistake” Rx to a new number. Answer **No**.

The record will be removed from the Immunizations section of the patient card.

**Declined or Refused Immunizations**

This section explains the process for recording immunizations that have been declined by the pharmacist or refused by the patient.

**NOTE:** Immunizations that have been declined by the pharmacist or refused by the patient can be noted from the F3 - Patient card or the F9 - Workflow card.

**Pharmacist Declined**

1. Call up the patient using the F3 Patient search, or select F9 - Workflow.

2. Select **Immunizations** from the right navigation pane.

3. Select the appropriate immunization record and click **D - Pharmacist Declined**.
4. Enter the reason for the declined in the space provided and click **Pharmacist Declined**.

5. In the **Immunizations** list, the record will show a **Status** of ‘Declined by Pharmacist’.
NOTE: In electronic mode, the immunization can also be declined by selecting Refuse Immunization from the Immunization screen.

Select a refusal reason and enter any comments in the space provided. Click OK.
Patient Refused

1. Call up the patient using the **F3 Patient** search, or select **F9 - Workflow**.

2. Select **Immunizations** from the right navigation pane.

3. Select the appropriate immunization record and click **R - Patient Refused**.

4. The **Enter a Comment** form will appear.
   
a. If the immunization was refused by the patient, select **Patient**. Enter a comment in the space provided and click **Patient Refused**.
b. If the immunization was refused by someone other than the patient, select **Someone else**. The Select agent, Last name, First name, and Relationship to patient fields will open.

Click the Select agent list. The patient’s linked family members will appear in the list. Select a patient or click the magnifying glass icon to search for and select a patient.

If the person does not have a patient card, manually enter their name in the Last Name and First Name fields.
The selected patient's name will populate in the **Last name** and **First name** fields. Select a **Relationship to patient**. Enter any comments in the space provided and click **Patient Refused**.

5. In the **Immunizations** list, the record will show a **Status** of ‘Refused by Patient’.
Status Types

This section explains each possible status that may be attributed to an immunization record.

Status

**Patient Consent Scan Skipped** - The patient consent has not yet been scanned; no claim has been submitted.

**Pending** - The immunization is partially complete, or has been saved for later; no claim has been submitted.

**Refused by Patient** - The immunization has been refused by the patient; no claim has been submitted.

**Signed Consent** - A signed consent form has been obtained and scanned back into the system.

**Completed** - The immunization is complete and the claim has been submitted.

**Completed Paper** - The immunization or Emergency Epinephrine shot has been completed in Paper Mode.

**Declined by Pharmacist** - The immunization has been declined by the pharmacist; no claim has been submitted.

**Printed Consent** - The consent form has been printed but has not been scanned into the system; no claim has been submitted (Paper Mode only).

**Ready for Administration** - A record of the Emergency Epinephrine shot has been created, but is not yet complete, or has been saved for later; no claim has been submitted.

Product Status

**Pending Claim** - The immunization or Emergency Epinephrine shot is complete but the claim has not yet been submitted.

**Claimed** - The immunization or Emergency Epinephrine shot is complete and the claim has been submitted.

**Not Completed Yet** - The immunization or Emergency Epinephrine shot is partially complete, or has been saved for later.

**No Product Applicable** - The immunization or Emergency Epinephrine shot has been declined by the pharmacist or refused by the patient. No product has been administered and no claim has been submitted.
Fee Status

No Fee Applicable - Indicates there is no charge to the patient for the immunization.
Reporting

Running reports for immunization products can be done in one of two ways: You can select the product(s) you want included in the report via the report form, or you can assign the immunization products to a drug group and run the report for that particular group. This section instructs on how to run reports for immunization products using either method.

Method 1: Selecting Drugs in the Report Form

1. Select the report you want to run from the Reports menu.

2. The report form will appear. Locate the Drug field and click Add.

3. The Drug Search form will appear. Search for and select a drug.
4. The drug will be added to the **Drug** list in the report form. Repeat steps 2-3 for each product you want included in the report.

5. Click **Print**. The report will generate for the selected drug products only.
Method 2: Using Drug Groups

If you use drug groups to run reports, you must first create a drug group and then assign all applicable products to that group. This is a one-time task that will expedite the reporting process going forward.

Setting up a Drug Group

1. Select Edit > Lists > Drug/Mixture Groups.

2. Click Ins or press the Insert key on your keyboard.

3. Enter a Group Name (e.g., ‘Immunization Products’) and click Save.

4. The drug group will be added to the Drug/Mixture Groups list. Click Close to exit the Edit Mast Lists / Groups form.
Assigning Drugs to a Drug Group

1. Call up an immunization product using the **F5 - Drug** search.

2. Ensure that ‘Influenza Immunization’ is selected from the ‘Drug Card Type’ Field.

3. Select **Ins** from the **Groups** frame.
4. Select the drug group. Click **Insert**.

5. The drug group will move from the **Available Groups** frame to the **Selected Groups** frame. Click **OK**.

6. The drug group will be added to the **F5 - Drug** card. Click **Save** to save changes to the drug record.

7. Repeat steps 1-5 for each immunization product your pharmacy uses.
Running a Report

1. Select the report you want to run from the Reports menu.

2. The report form will appear. Locate the Drug Groups field and click F2.

3. Select the drug group your immunization products have been assigned to. Click Insert.
4. The drug group will move from the **Available** frame to the **Selected** frame. Click **OK**.

![Select Drug Groups](image1)

5. The drug group will appear in the **Drug Groups** field in the report form. Repeat steps 2-4 for each drug group you want included in the report.

![Drug Usage Report](image2)

If you want to exclude the selected drug groups from the report (i.e., run the report for all drugs except those in the selected drug group), check the **Exclude** checkbox.

![Drug Usage Report](image3)
6. Click **Print**. The report will generate for the selected drug group(s) only.

---

**Drug Usage Report**

Kroll Pharmacy, 100 Krollwin Drive, Vancouver BC V2V 2V2
Phone: (222) 222-2222 Fax: (888) 888-8888

Report Parameters
- Fill Date: 01/01/2016 to 12/31/2016
- Drug Groups: Immunization Products
- Include Fee For Service Rx

Drug Usage Report

<table>
<thead>
<tr>
<th>Drug</th>
<th>Mfr</th>
<th>DIN</th>
<th>Pack Size</th>
<th>On Hand</th>
<th>Qty</th>
<th>AUC</th>
<th>Cost</th>
<th>Markup</th>
<th>Fees</th>
<th>Amount</th>
<th># of Rx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flu6 15/15 Influenza Vaccine (IV)</td>
<td>NOV</td>
<td>02362384</td>
<td>1</td>
<td>100</td>
<td>0.5</td>
<td>6.57</td>
<td>7.22</td>
<td>0.00</td>
<td>10.49</td>
<td>17.71</td>
<td>1</td>
</tr>
<tr>
<td>Flu6 15/15 Influenza Vaccine (IV)</td>
<td>GSK</td>
<td>02019886</td>
<td>1</td>
<td>999999</td>
<td>1</td>
<td>10.00</td>
<td>0.00</td>
<td>0.00</td>
<td>10.49</td>
<td>10.49</td>
<td>1</td>
</tr>
<tr>
<td>Truvada (A)</td>
<td>ABB</td>
<td>02269562</td>
<td>10</td>
<td>4997</td>
<td>2.5</td>
<td>27.95</td>
<td>30.75</td>
<td>0.00</td>
<td>52.45</td>
<td>83.20</td>
<td>5</td>
</tr>
</tbody>
</table>

Net Values
- 44.52
- 37.97
- 0.00
- 73.43
- 111.40
- 7

Number of Patients Included In This Report
- 6

Average Rx Value
- 15.91